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Purpose

Purpose
The Class 6 D-Style SmartMotor™ Installation and Startup Guide (the document you are currently
reading) provides an overview of the Class 6 D-style SmartMotor, along with information on unpacking,
installation and start up. This guide is meant to be used in conjunction with the SmartMotor™
Developer's Guide, which describes the SmartMotor features, SMI software, programming, commands,
and other topics related to SmartMotor application development.

NOTE: The features described in this guide apply to the Class 6 D-style SmartMotor with firmware
version 6.4.x.x (6.4.2.54 or later is recommended). Additionally, those motors require SMI software
version 3.0.0.73 or later for complete feature support.

Class 6 D-Style SmartMotor

The information in this guide is meant to be used by properly trained technical personnel only. Moog
Animatics conducts classroom-style SmartMotor training several times per year, as well as product
seminars and other training opportunities. For more information, please see the Moog Animatics
website or contact your Moog Animatics representative.

Combitronic Technology
The most unique feature of the SmartMotor is its ability to communicate with other SmartMotors and
share resources using Moog Animatics’ Combitronic™ technology. Combitronic is a protocol that
operates over a standard CAN interface. It may coexist with the CANopen protocol. It requires no single
dedicated controller1 to operate. Each SmartMotor connected to the same network communicates on
an equal footing, sharing all information, and therefore, sharing all processing resources.

NOTE: Combitronic over Ethernet, which allows Combitronic communication on the Industrial
Ethernet network, is not currently available on the Class 6 D-style SmartMotor.

For additional details, see the SmartMotor™ Developer's Guide.

1Moog Animatics has replaced the terms "master" and "slave" with "controller" and "follower",
respectively.
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I/O Device CAN Bus Controller

I/O Device CAN Bus Controller
Expanded I/O capability allows the SmartMotor to interface with standard CiA 301 CANopen devices
and function as the I/O device CAN bus controller (i.e., no external bus controller is needed). For more
details, see the SmartMotor™ Developer's Guide. For CANopen object descriptions, see the
SmartMotor™ CANopen Guide.

CANopen

ABS Encoder
SmartMotor

CANopen

Valve Block

CANopen

Remote I/O

Be sure to comply with the guidelines for CAN bus cabling and termination.

SmartMotor SmartMotor SmartMotor

Without data collision!
TM

Motor to MotorMotor to I/O®

120 ohm
terminator

120 ohm
terminator

SmartMotor as I/O Device CAN Bus Controller
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Safety Information

Safety Information
This section describes the safety symbols and other safety information.

Safety Symbols
The manual may use one or more of these safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard, where
failure to comply with the instructions could result in serious injury to the operator
or major damage to the equipment.

CAUTION: This symbol indicates a potentially minor hazard, where failure to
comply with the instructions could result in slight injury to the operator or minor
damage to the equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Other Safety Considerations
The Moog Animatics SmartMotors are supplied as components that are intended for use in an
automated machine or system. As such, it is beyond the scope of this manual to attempt to cover all
the safety standards and considerations that are part of the overall machine/system design and
manufacturing safety. Therefore, this information is intended to be used only as a general guideline for
the machine/system designer.

It is the responsibility of the machine/system designer to perform a thorough "Risk Assessment" and to
ensure that the machine/system and its safeguards comply with the safety standards specified by the
governing authority (for example, ISO, OSHA, UL, etc.) for the site where the machine is being installed
and operated. For more details, see Machine Safety on page 10.

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are properly sized
for the specific application. Undersized motors may: perform poorly, cause excessive downtime or
cause unsafe operating conditions by not being able to handle the loads placed on them. The System
Best Practices document, which is available on the Moog Animatics website, contains information and
equations that can be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the approved and
validated system. Specification changes or firmware upgrades require the approval of the system
designer and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating environment
for dust, high-humidity or presence of water (for example, a food-processing environment that requires
water or steam wash down of equipment), corrosives or chemicals that may come in contact with the
machine, etc. Moog Animatics manufactures specialized IP-rated motors for operating in extreme
conditions. For details, see the Moog Animatics Product Catalog.
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Machine Safety

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the machine/system
builder must perform a "Risk Assessment", which is often based on the ISO 13849 standard. The
design/implementation of barriers, emergency stop (E-stop) mechanisms and other safeguards will be
driven by the Risk Assessment and the safety standards specified by the governing authority (for
example, ISO, OSHA, UL, etc.) for the site where the machine is being installed and operated. The
methodology and details of such an assessment are beyond the scope of this manual. However, there
are various sources of Risk Assessment information available in print and on the internet.

NOTE: The next list is an example of items that would be evaluated when performing the Risk
Assessment. Additional items may be required. The safeguards must ensure the safety of all
personnel who may come in contact with or be in the vicinity of the machine.

In general, the machine/system safeguards must:
l Provide a barrier to prevent unauthorized entry or access to the machine or system. The barrier
must be designed so that personnel cannot reach into any identified danger zones.

l Position the control panel so that it is outside the barrier area but located for an unrestricted
view of the moving mechanism. The control panel must include an E-stop mechanism. Buttons
that start the machine must be protected from accidental activation.

l Provide E-stop mechanisms located at the control panel and at other points around the
perimeter of the barrier that will stop all machine movement when tripped.

l Provide appropriate sensors and interlocks on gates or other points of entry into the protected
zone that will stop all machine movement when tripped.

l Ensure that if a portable control/programming device is supplied (for example, a hand-held
operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional system design
considerations and safeguards beyond those listed in this section. For details, see the safety
standards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the site
where the machine is being installed and operated.

l Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys, tooling, etc.).

l Prevent contact with a part that is thrown from the machine tooling or other part-handling
equipment.

l Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other hazards that
may be present at the machine.

l Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.

l Provide a proper control system, program logic and error checking to ensure the safety of all
personnel and equipment (for example, to prevent a run-away condition). The control system
must be designed so that it does not automatically restart the machine/system after a power
failure.

l Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety, operation,
maintenance and programming, along with training for all machine operators, maintenance technicians,
programmers, and other personnel who may have access to the machine. This documentation must
include proper lockout/tagout procedures for maintenance and programming operations.
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Additional Equipment and Considerations

It is the responsibility of the operating company to ensure that:
l All operators, maintenance technicians, programmers and other personnel are tested and
qualified before acquiring access to the machine or system.

l The above personnel perform their assigned functions in a responsible and safe manner to
comply with the procedures in the supplied documentation and the company safety practices.

l The equipment is maintained as described in the documentation and training supplied by the
machine/system designer.

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the need for
additional equipment. In general, it is the responsibility of the operating company to ensure that:

l Unauthorized access to the machine is prevented at all times.

l The personnel are supplied with the proper equipment for the environment and their job
functions, which may include: safety glasses, hearing protection, safety footwear, smocks or
aprons, gloves, hard hats and other protective gear.

l The work area is equipped with proper safety equipment such as first aid equipment, fire
suppression equipment, emergency eye wash and full-body wash stations, etc.

l There are no modifications made to the machine or system without proper engineering
evaluation for design, safety, reliability, etc., and a Risk Assessment.

Safety Information Resources
Additional SmartMotor safety information can be found on the Moog Animatics website; open the topic
"Controls - Notes and Cautions" located at:

https://www.animatics.com/support/downloads/knowledgebase/controls---notes-and-cautions.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html

ANSI-RIA robotic safety information can be found at:

http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:

http://ulstandards.ul.com/standards-catalog/

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/growth/single-market/european-standards/harmonised-standards/index_en.htm
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Additional Documents

Additional Documents
The Moog Animatics website contains additional documents that are related to the information in this
manual. Please refer to these lists.

Related Guides
l SmartMotor™ Developer's Guide

http://www.animatics.com/smartmotor-developers-guide

l SmartMotor™ Homing Procedures and Methods Application Note

http://www.animatics.com/homing-application-note

l SmartMotor™ System Best Practices Application Note

http://www.animatics.com/system-best-practices-application-note

In addition to the documents listed above, guides for fieldbus protocols and more can be found on the
website: https://www.animatics.com/support/downloads.manuals.html

Other Documents
l SmartMotor™ Certifications

https://www.animatics.com/certifications.html

l SmartMotor Developer's Worksheet
(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port Status,
Serial Port Status, RMODE Decoder and Syntax Error Codes)

https://www.animatics.com/support/downloads.knowledgebase.html

l Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html

Additional Resources
The Moog Animatics website contains useful resources such as product information, documentation,
product support and more. Please refer to these addresses:

l General company information:

http://www.animatics.com

l Product information:

http://www.animatics.com/products.html
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Additional Resources

l Product support (Downloads, How-to Videos, Forums and more):

http://www.animatics.com/support.html

l Contact information, distributor locator tool, inquiries:

https://www.animatics.com/contact-us.html

l Applications (Application Notes and Case Studies):

http://www.animatics.com/applications.html
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SmartMotor Overview

SmartMotor Overview
This chapter provides an overview of the design philosophy and functionality of the Moog Animatics
SmartMotor. It also provides information on SmartMotor features and options, and where to find
related documents and additional resources.
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SmartMotor Introduction

SmartMotor Introduction
The Moog Animatics SmartMotor™ servo is an industrial servo motor with motion controller integrated
into a compact package. Its design is based on these objectives:

1. Reduce development time

2. Lower machine-production cost

3. Simplify the machine (design, build and support)

Class 6 D-Style SmartMotor with Industrial Ethernet and Inline Brake Options

The SmartMotor is powerful and unique because of its ability to control an entire machine. The
combination of programmability, networking, I/O and servo performance is unmatched. The SmartMotor
brings savings and value to the machine builder by removing complex and costly elements in the
machine design, such as PLCs, sensors, I/O blocks, cabinets, etc.

SmartMotor Features and Options
NOTE: All specifications are subject to change without notice. Consult the factory for the latest
information.

The Class 6 D-style SmartMotor is available only in a D-style configuration. All SmartMotors offer
these features:

l Full floating-point math and trigonometric functions with 32-bit precision results

l Dual trajectory generators enabling relative and absolute position moves or velocity moves on
top of gearing or camming

l Advanced gearing allowing preset traverse and take-up winding parameters including dwells and
wrap counts

l Advanced camming including cubic spline interpolation and dynamic frequency and amplitude
changes. Add onto gearing for complex traverse and take-up winding patterns.

l Stand-alone, multi-axis linear interpolation with as many as 120 SmartMotors at a time
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Class 6 D-Style Motors

l Virtual-axis control into camming through gearing, which enables stand-alone, multi-axis
coordinated motion

l Programmable and non-programmable protection features (both hardware and software)

A note about SmartMotor part numbers:

The SmartMotor uses a coded part number, which contains characters that describe the motor number,
frame style and options. For details on decoding the SmartMotor part number, refer to the
Understanding SmartMotor Part Numbers document at this address:

https://www.animatics.com/support/downloads.knowledgebase.html

Class 6 D-Style Motors
The Class 6 SmartMotor is available in an D-style configuration.

Standard Features

All Class 6 D-style SmartMotors have these standard features:
l Batteryless (and gearless) absolute multiturn encoder, no battery backup needed, see
Batteryless Absolute Multiturn Encoder on page 65

l High density 26-pin (the "HD26") connector in a DA shell, supports additional I/O and more
communications options

l Ten channels of expanded, industry standard 24 VDC I/O (I/O 0 – 9)

l Dedicated 4-20mAmp analog connection

l Dedicated Drive-Enable input and NOT-FAULT output

l Single or dual (separated) drive and control power input, both are standard and enabled
automatically depending on power connection(s)

l Differential encoder input for reduced interference from electrically noisy environments

l 105 ºC upper operating temperature limit for higher torque output

l LEDs: Bi-colored LED indicators to show error codes, provide network status and
communications activity

l CAN over D-Sub (CDS) and 7W2 (CDS7) connectors

l Communications: RS-232, RS-485, Combitronic, USB, Ethernet, CAN bus, with no loss in I/O

l Upgraded processors (as compared to Class 5) with higher clock speeds, more RAM and
EEPROM, resulting in more space for more complex user programs, faster program execution,
and built in homing functions

l SMI software available, optionally used for application development and debugging

l I/O support for Drive Enable, Position Limits and Fault status

l Motor sample rate: 16 kHz
l Position Capture Register from signal-ended, ground-referenced external input (non-differential)
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Optional Features

l External encoder input supporting either A-quad-B or Step-and-Direction modes of counting
l Machine Line Shaft Input support

l Maximum individual line frequency at either the A or B input is 1.5 MHz

All firmware options include:
l Modbus Remote Terminal Unit (RTU) Follower (RS-485 COM 1), see the SmartMotor™ Modbus
RTU Guide

l DMX Follower (RS-485 COM 1), see the SmartMotor™ DMX Guide

Optional Features

These Class 6 D-style features are optional:

NOTE: These options can be ordered individually or combined.
l Inline brake option (available on all frame sizes)

l Industrial Ethernet with dual-port switch (available on all frame sizes) — see the available
fieldbus communications protocols below

l "DT" high torque option, applies to SM23166, SM23266, SM23376, SM34166, SM34266 models
- contact Moog Animatics for details

l Shaft options such as 1 or 2 flats, or keyed - contact Moog Animatics for details

These fieldbus communications protocols are available on the Class 6 D-style motors.

NOTE: These fieldbus protocols require the Industrial Ethernet option.
l EtherNet/IP (-EIP) option

l EtherCAT (-EEC) option

l PROFINET (-EPN) option

The Class 6 D-style motors are available in these NEMA frame sizes:
l NEMA 17

l NEMA 23

l NEMA 34

For additional information on SmartMotor features, specifications, torque curves and more, see the
corresponding SmartMotor product page for your motor. SmartMotor product pages are available from
the Products menu on the Moog Animatics website.

Connectors and LED Locations

The next figure shows the connector and LED location for the Class 6 D-style SmartMotor. For details
on the motor connectors, see Connecting the System on page 34. For details on the LED functions, see
Understanding the Status LEDs on page 46.

CAUTION: For Class 6 D-style SmartMotors, pins 11 and 12 of the 26-pin D-sub
port are intended for control power only. Attempts to power a motor through those
pins as main servo drive power could result in immediate damage to the electronics
and will void the warranty.
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Fieldbus Options

26-Pin D-Sub I/O (HD26)

7-Pin Combo D-Sub 
Power & I/O (7W2)

Power/Servo LED

Trajectory LED

Class 6 D-Style Motor Connectors and LEDs

Fieldbus Options
This section details the Fieldbus communications protocol options that are available on Class 6 D-style
SmartMotors.

CANopen Fieldbus Protocol

NOTE: This protocol is a standard feature on the Class 6 D-style SmartMotor.

The CANopen fieldbus protocol provides these features:
l Basic motion commands available through the CiA V4.02 specification

l Ability to read/write SmartMotor variables

l Use of onboard I/O through CANopen, SmartMotor programs or serial commands

l Ability to run 1000 SmartMotor subroutines through CANopen

l Online diagnostics of the SmartMotor through SMI software and serial connection

l Logical addressing for 127 nodes

l User program status/interrupts can be triggered by receive PDOs

l Baud rates of 20 Kbps, 50 Kbps, 125 Kbps (default), 250 Kbps, 500 Kbps and 1 Mbps

l Expanded I/O capability allows the SmartMotor to interface with standard CiA 301 CANopen
devices and function as the I/O device CAN bus controller (i.e., no external bus controller is
needed). For more details, see the SmartMotor™ Developer's Guide. For CANopen object
descriptions, see the SmartMotor™ CANopen Guide.

NOTE: For the Class 6 D-style SmartMotor, there is no separate CAN connector on the back of the
motor. CAN bus connections are available on both the 7-pin and HD26-pin connectors. For details,
see CDS Schematic on page 40.

For more details, see the SmartMotor™ CANopen Guide.
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EtherCAT Fieldbus Protocol

EtherCAT Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 D-style motors.

The EtherCAT fieldbus protocol provides these features:
l Command/Response Codes for SmartMotor commands

l CiA 402 Motion Modes: Profile Position (PP), Profile Velocity (PV), Torque (TQ), Cyclic Sync
Position (CSP), Cyclic Sync Velocity (CSV), Cyclic Sync Torque (CST)

l Dynamic PDO mapping

l Configurable Sync Manager 2 and 3 assignment

l DC-sync Subordinate mode with SYNC0 and SYNC1

l DC-sync follower

l Selectable Homing modes (with or without index pulse)

l Selectable Interpolation modes (spline or linear)

l Touch Probe function allows the motor's position to be captured on a specific event

For the EtherCAT connector diagram and pinouts, see Industrial Ethernet Network on page 44.

For more details, see the Class 6 SmartMotor EtherCAT Guide.

PROFINET Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 D-style motors.

The PROFINET fieldbus protocol provides these features:
l Command/response codes for SmartMotor commands

l Use of on-board I/O through PROFINET, SmartMotor program, or RS-485 commands

l The Moog Animatics communications profile over PROFINET is intended to integrate well with a
PLC that continuously transmits and receives cyclic data; the command and response codes
achieve this through a handshaking mechanism

For the PROFINET connector diagram and pinouts, see Industrial Ethernet Network on page 44.

For more details, see the Class 6 SmartMotor™ PROFINET Guide.

EtherNet/IP Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 D-style motors.

The EtherNet/IP fieldbus protocol provides these features:
l Access to unique SmartMotor commands and parameters.

l Use of on-board I/O through EtherNet/IP, SmartMotor program, or RS-485 commands

l The Moog Animatics communications profile over EtherNet/IP is intended to integrate well with
a PLC that continuously transmits and receives cyclic data (implicit messaging); the command
and response codes achieve this through a handshaking mechanism
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EtherNet/IP Fieldbus Protocol

l Certain configuration data is held in nonvolatile storage in the SmartMotor; therefore, the motor
data EEPROM must be correctly initialized before EtherNet/IP operation

l Supports extended function CIP Position Controller Device

l Supports Modbus TCP/IP, see the Class 6 SmartMotor™ Modbus TCP/IP Guide

l Supports Ethernet Serial Encapsulation, see the Class 6 SmartMotor Ethernet Serial
Encapsulation Guide

l Control modes for Profile Torque, Profile Velocity and Profile Position modes

l Change Dynamic – motion profile changes on the fly

l Implicit exchange access to many SmartMotor parameters

l Supports the SMI software Find/Detect operations over Ethernet — the SmartMotor must be
previously configured (through COM or USB) with a valid IP address

For the EtherNet/IP connector diagram and pinouts, see Industrial Ethernet Network on page 44.

For more details, see the Class 6 SmartMotor EtherNet/IP Guide.
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Dual Power Configuration

Dual Power Configuration
The Class 6 D-style SmartMotor's hardware dual power configuration allows the controller and drive
amplifier to be powered from separate DC power supplies (see the next figure).

NOTE: I/O outputs cannot be powered from the 7W2 connector.

This configuration provides these advantages:
l Controller can be powered from a +24 VDC (±20%) 32 VDC max. power supply

l Load surges will not cause a power surge on the controller

NOTE: All Class 6 D-style SmartMotors are designed to allow the use of separate drive and control
power supplies. No special ordering option is needed for those SmartMotors.

The next figure shows the connectors used for the dual power configuration.

Control power supplied to this connector
(+24 VDC (±20%) 32 VDC max.)

Drive Amp power supplied to
this connector (24-48 VDC)

NOTE: These motors can operate on 
Drive Amp power down to +20 VDC, 
but it is not recommended due to 
greatly reduced performance — opti-
mum performance is achieved at 48 
VDC.

D-Style Dual Power Configuration Drive and Control Power Connections

Although you can supply the control and drive power from one power supply, you will only get the full
benefits and maximum protection by using separate power supplies, as noted in the previous figure.
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SmartMotor Theory of Operation

SmartMotor Theory of Operation
The Moog Animatics SmartMotor is an entire servo control system built inside of a servo motor. It
includes a controller, an amplifier and an encoder. All that is required for it to operate is power and
either an internal program or serial commands from outside (or both). To make the SmartMotor move,
the program or serial host must set a mode of operation, state a target position with/or a maximum
velocity at which to travel to that target, and a maximum acceleration. After these three parameters
are set, the two limit inputs are pulled high or deactivated, and the Drive Enable input is satisfied, a
"Go" command starts the motion profile.

The core functional areas of the SmartMotor are:
l Motion Control Functions (see Motion Details in the SmartMotor™ Developer's Guide)

l System Control Functions (see Program Flow Details and see System Status in the SmartMotor™
Developer's Guide)

l Communication Functions (see Communication Details in the SmartMotor™ Developer's Guide)

l I/O Functions (see I/O Control in the SmartMotor™ Developer's Guide)
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SmartMotor Theory of Operation

The next block diagram illustrates the relationship between the functional areas in the SmartMotor.
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Getting Started

Getting Started
This chapter provides information on getting started with your SmartMotor.

Unpacking and Verifying Your Shipment 26

Installing the SMI Software 26

Installation Procedure 26

Installation Verification 29

Accessing the SMI Software Interface 29

Understanding the Power Requirements 31

SmartMotor Power Requirements 31

CPU, I/O and Communications Power 32

CPU Power Requirements 33

I/O Power Requirements 33

Communications Power Requirements 33

Drive Enable Input 33

Connecting the System 34

Minimum Requirements 34

Connectors and Pinouts 35

D-Style Connections At A Glance 35

Demo or Development System 36

RS-232 Through USB 36

Adding a USB Adapter 36

RS-232 with Protective Shunt 37

RS-232 Multidrop with Add-A-Motor Cables 37

RS-232 Multidrop with Custom X-Y-Z Cable 38

USB to HD26 Connector 38

Dual Power Configuration 38

CDS Schematic 40

CDS on the HD26 Connector 40

CDS on the 7W2 Connector (CDS7) 40

Industrial Ethernet Network 44

Maximum Cable Length 45

Ethernet Cables 45
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Getting Started

Understanding the Status LEDs 46

Detecting and Communicating with the SmartMotors 47

Understanding the Detection and Configuration Options 47

Using the Find Motors Button 47

Using the Detect Motors Feature 50

Checking and Clearing the Status Bits 52

Polling the Motor 53

Clearing the Overtravel Limits and Fault Bits 54

Moving the SmartMotor 55

Making the Motor Move 55

Setting and Reporting Torque 56

Checking the Motor Position 57

Viewing the Motor Position with a Report Command 57

Viewing the Motor Position with the Motor View Tool 57
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Unpacking and Verifying Your Shipment

Unpacking and Verifying Your Shipment
Your Moog Animatics SmartMotor and accessories are carefully assembled, tested, inspected and
packed at the factory.

When you receive your shipment, you should:
l Visually inspect all shipping containers for visible signs of shipping damage. If you see damage,
please notify your carrier and then contact Moog Animatics to report the problem.

l Carefully unpack each component and verify the part number with your order. If there are any
differences or missing items, please contact Moog Animatics so that the shipment can be
corrected.

l Keep all boxes and packing materials. These may be needed for future storage or shipment of
the equipment.

Installing the SMI Software
The SmartMotor Interface software (SMI software) provides a convenient user interface for
programming the SmartMotor. Before you can use the SMI software, it must be installed on a Microsoft
Windows PC.

The SMI software is distributed on CD-ROM or USB stick, and is also available as a download from the
Moog Animatics website. To download the latest version of the SMI software, use this address:

http://www.animatics.com/smi

Then scroll to the bottom of the page and click the Free Download button.

SMI Download Button

The installation package is downloaded to your system.

NOTE: The SMI software requires Microsoft Windows XP or later.

Installation Procedure
NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

To install the SMI software:
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Installation Procedure

1. Double-click the executable package (.MSI) file to begin the installation. In some versions of
Microsoft Windows, you may receive a security warning message about running the file. You can
ignore this message.

If this is a new installation, go to the next step.

If this is an upgrade to a previous installation, you will see the window below. Select Remove,
click Next and remove the existing software from your PC using the instructions.

After removing the existing software, restart the installation process.

NOTE: All personal settings and user files will be retained.
2. Click Next to proceed. The Installation Configuration page opens.
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Installation Procedure

3. Click Next to proceed. The SMI software installation wizard starts and the Welcome page opens.

4. After you have finished reviewing the welcome information, click Next to proceed. Use the on-
screen instructions to complete the SMI software installation.

Moog Animatics Class 6 D-Style SmartMotor™ Installation and Startup Guide, Rev. D

Page 28 of 72



Installation Verification

5. When the installation has completed, the installation status message page opens, as shown in
the next figure. Click Finish to complete the installation and close the installation wizard.

NOTE: After the software is installed, be sure to restart your computer before running the SMI
software.

Installation Verification
To verify the installation, navigate to the C:\Program Files (or folder C:\Program Files x86) folder. You
should see these folders:

Accessing the SMI Software Interface
The SmartMotor Interface software (SMI software) communicates with a single or series of
SmartMotors from a Windows-based PC and gives you the capability to control and monitor the status
of the motors. The SMI software also allows you to write programs and download them into the
SmartMotor’s long-term memory.

NOTE: Every SmartMotor has an ASCII interpreter built in. Therefore, it is not necessary to use the
SMI software to operate a SmartMotor.

To open the SMI software, double-click the SmartMotor Interface shortcut on the Windows desktop.

SmartMotor Interface Shortcut
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Accessing the SMI Software Interface

Optionally, to open the SMI software from the Microsoft Windows Start menu, select:

Start > All Programs > Animatics > SMI3 > SmartMotor Interface

The SMI software interface opens, as shown in the next figure.

Menu bar

Toolbar

Con!guration
window

Terminal
window

Information
window

Program
editor

SMI Software Interface

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

These are the primary features in this interface:
l Menu Bar: All of the windows and functions of the SMI software can be accessed through the
menu bar. Many of these are also accessible through the icons on the toolbar.

l Toolbar: The toolbar contains a collection of icons for accessing the primary features of the SMI
software. Depending on the current state of the SMI software and the currently-active window,
some toolbar buttons may be disabled.

l Configuration Window (far-left window): This window is used to display the current
communication and detected motor configuration when no project is open, or the communication
and motor configuration defined in an open project.

l Terminal Window (middle window): This window is used to communicate with SmartMotors (for
example, issue single-line commands to one or all motors). The response (if any) is also shown in
this window.

l Information Window (lower window): This window is used to display the results of user
operations.

l Program Editor (far-right window): This window is used to manage, edit and print user programs.
Most of the procedures for using the editor should seem familiar if you have used other
Windows-based text editors.

For more details about these items, see the SMI software online help, which can be viewed in SMI by
pressing F1 or selecting Help > Contents - SMI Software Help.
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Understanding the Power Requirements

Understanding the Power Requirements
This section describes the power requirements for Class 6 D-Style SmartMotor power, CPU power, I/O
power and Communications power.

SmartMotor Power Requirements

CAUTION: If power is reversed on any standard SmartMotor, immediate damage
WILL occur and the SmartMotor will no longer operate.

Requirement:
For Class 6 D-Style SmartMotors, there are two options: 1) power the entire motor (drive and control)
from the main input on the 7W2 connector, or 2) the recommended "dual power" method, power the
drive stage through the 7W2 connector and power the controller through the HD26 D-sub connector.
Refer to the next figure. For more details on the dual power configuration, see Dual Power
Configuration on page 38.

Drive

Controller

SmartMotor

Power 
Supply

 11   10    
   9

7W2

D-sub

Drive

Controller

SmartMotor

Power 
Supply

 11   10    
   9

7W2

D-sub
Power 
Supply

Single Power Supply Dual Power Supplies
Powers Drive and Controller Maintains Controller if Drive Power is Cut

Dual

Single

Single vs. Dual Power Configuration

CAUTION: Control power for Class 6 D-Style motors must be nominal 24 VDC
(±20%). They are not rated for 48 VDC.

Control power requires nominal 24 VDC (±20%), do not exceed 32 VDC; motor power requires from 24
VDC to 48 VDC, do not exceed 48 VDC. Also, note that:

l If I/Os are used, the control power pins must be supplied with power, as those pins provide sig-
nal power for the I/O, see I/O Power Requirements on page 33.

l If the brake option is installed, brake power is supplied by the drive power input on the 7W2
connector. Therefore,

l If drive power is lost, the brake will de-energize and hold the shaft.

l If control power is not supplied on the HD26 connector, but is supplied through the 7W2
connector, the brake will still work.

NOTE: These motors can operate on power down to +20 VDC, but it is not recommended due to
greatly reduced performance -- optimum performance is achieved at 48 VDC.

Details: Large SmartMotors can draw high current. Therefore, heavy gauge wire is required to connect
the large motors.

Voltages below 18 VDC could cause a brownout shutdown of the CPU, or what would appear as a
power-off reset, under sudden load changes.
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CPU, I/O and Communications Power

When relying on torque/speed curves, pay close attention to the voltage on which they are based.

During hard, fast decelerations, a SmartMotor can pull up supply voltages to the point of damage if a
shunt resistor pack is not used. Protective shunts are available from Moog Animatics.

CAUTION: Many vertical applications and applications with hard, fast
decelerations require shunts to protect the SmartMotor from damage. Note that
shunts should always be placed between the motor input and any disconnect or E-
stop relay to protect the motor when power is off or E-stop relay contacts are
open.

Special care must be taken when near the upper voltage limit or in vertical applications that can back-
drive the SmartMotor. Gravity-influenced applications can turn the SmartMotor into a generator and
back-drive the power supply voltage above the safe limit for the SmartMotor. Many vertical
applications require a shunt to protect the SmartMotor from damage. Protective shunts are available
from Moog Animatics.

CPU, I/O and Communications Power

CAUTION: The maximum allowed supply voltage is 32 VDC. Voltages greater than
the maximum value will damage the equipment.

The CPU can be powered directly from the drive (single power configuration), or it can be powered
separately from the drive (dual power configuration). For details, see the discussion earlier in this topic,
and also see Dual Power Configuration on page 38.

For dual power configurations, the HD26 control power input pins can draw 24 VDC @ 650 mA in total
(CPU power and I/O power), see the next two sections for details. If the Ethernet option is included, it
uses an additional 100 mA, see the next figure.

NOTE: If control power is not supplied on the HD26 input (pin 11), outputs will not be able to be
driven. However, all inputs can still be detected.

Controller
250 mA

Ethernet Option
100 mA

Control Power Input
Output load = 200 mA

Output load = 100 mA

Output load = 50 mA

Output load = 50 mA

Control Power Example

Controller driving four outputs
<= 200 mA each, 400 mA total

NOTE: Total output load 
not to exceed 400 mA

min = 250 mA
max = 750 mA

Control Power Example with Ethernet Option and Four 100 mA Outputs
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CPU Power Requirements

CPU Power Requirements

For dual power configurations, where the controller and drive are each powered separately, the user-
supplied 24 VDC controller power supply should be capable of handling up to 6 watts (250 mA) for the
CPU alone; see the next section for additional I/O power requirements.

Requirement: Nominal 24 VDC (range 18-32 V) @ 250mA must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 11) on the HD26-pin D-sub connector.

I/O Power Requirements

Requirement: Nominal 24 VDC (range 18-32 V) @ 400 mA must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 11) on the HD26-pin D-sub connector.

NOTE: This I/O is not isolated from the CPU's power supply and the motor drive.

NOTE: Unlike the M-style, the D-style does not provide 24 VDC Control/IO output power.

Specifications:
NOTE: All specifications assume nominal 24 VDC (range 18-32 V) Control power. The maximum
allowed supply voltage is 32 VDC. Voltages greater than the maximum value will damage the motor.

Input Pins Electrical Specification:

l Input Voltage Low Level Threshold: 3.6 V maximum
l Input Voltage High Level Threshold: 6.0 V minimum

Output Pins Electrical Specification:

l Output Loading:
l Nominal load: 200 mA each
l Maximum load: not to exceed 400 mA total (all outputs combined)

l Output voltage: 23 V maximum load

Communications Power Requirements

Requirement: Nominal 24 VDC (range 18-32 V) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 11) on the HD26-pin D-sub connector.

NOTE: The RS-485 signal is not isolated from the CPU's power supply or the motor drive.

Drive Enable Input
The Drive Enable input (HD26, pin 8) must be connected and activated with 24V. For the input location,
see Connectors and Pinouts on page 35.
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Connecting the System

Connecting the System
The topics listed below show system connections and cable diagrams for typical Class 6 D-style motor
installations. For connector specifications, I/O and Channel information, and example I/O connections,
see Connectors, Pinouts and Examples on page 59.

For Class 6 D-style motors:
l Connectors and Pinouts on page 35
l Demo or Development System on page 36
l RS-232 Through USB on page 36
l RS-232 with Protective Shunt on page 37
l RS-232 Multidrop with Add-A-Motor Cables on page 37
l RS-232 Multidrop with Custom X-Y-Z Cable on page 38
l USB to HD26 Connector on page 38
l Dual Power Configuration on page 38
l CDS Schematic on page 40
l Industrial Ethernet Network on page 44

As you can see, many configurations are possible.
l If you are installing one of these typical configurations and Moog Animatics-supplied cables,
simply use the connection information in this section.

l If you are using your own cables or a non-typical configuration, review the information in this
section and also see Connectors, Pinouts and Examples on page 59.

Advanced communication information is available in Communication Details in the SmartMotor™
Developer's Guide.

Minimum Requirements
At minimum, you will need these items:

1. A Class 6 D-Style SmartMotor

2. A computer running Microsoft Windows and the SMI software

3. A DC power supply and power cable for the SmartMotor

4. A data cable to connect the SmartMotor to the computer’s serial port or through a USB to serial
adapter, see D-Style Connections At A Glance on page 35.

OR a USB cable to connect the SmartMotor to the computer's USB port, see USB to HD26
Connector on page 38,

OR if your SmartMotor is equipped with the Ethernet option, a Cat 5 (or better) Ethernet cable
to connect the motor to the computer's Ethernet port, see Industrial Ethernet Network on page
44.
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Connectors and Pinouts

Connectors and Pinouts
The next figure provides a brief overview of the connectors and pinouts available on the D-style
SmartMotors. For full details, see Class 6 D-Style Connector Pinouts on page 60.
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NOTE: The dual power configuration is recommended. For details, see Dual Power Configuration on
page 38.

D-Style Connections At A Glance
The next figure provides a quick overview of the cables and connections for the Class 6 D-style motor.

NOTE: The USB connection on CBLHD26-ASM is meant only for programming from the SMI
software; it is not recommended for running the motor.

USB232485 B

KITUSB232485

CBLSM1-xM

PS24V8AG-110

or PS42V6AG-110

SM23166D

OR

CBLHD26-ASM

Connector assembly from Moog Animatics; 

cable is customer supplied

USB A Male to Micro USB

(Customer supplied)

B

Jumper TERM*

(under cover)

*When ON, activates 

120 ohm terminator

CAN bus
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Demo or Development System

Demo or Development System

CAUTION: This configuration is designed for development, training or demo
purposes only. It is not intended for use in an industrial (manufacturing)
environment.

 

CBLSM1-DEMO

PWR116V

CBLAC4

RS-232 Through USB

USB232485B

KITUSB232485 CBLSM1-xM

PS24V8AG-110

or PS42V6AG-110

Adding a USB Adapter

Moog Animatics sells a USB to Serial adapter (PN KITUSB232485), which is used on PCs that don't
have a built-in serial port. The adapter allows you to connect from an available USB port to the serial
interface on the SmartMotor. The adapter simply connects between the USB port and the serial cable.
For an installation instructions, see the file "USB Driver Install Tutorial.pdf" at
https://www.animatics.com/modals/software/usb-driver-for-use-with-cable-kitusb232485.html.
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RS-232 with Protective Shunt

RS-232 with Protective Shunt

CBLSM1-xM

CBLDC1

PS24V8AG-110

or PS42V6AG-110

SHUNT42V100W

or SHUNT42V200W

RS-232 Multidrop with Add-A-Motor Cables

CBLSM1-xM CBLSMADD-xM

PS24V8AG-110 or

PS42V6AG-110
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RS-232 Multidrop with Custom X-Y-Z Cable

RS-232 Multidrop with Custom X-Y-Z Cable

CBLSM1-X-Y-Z

USB to HD26 Connector
NOTE: The USB connection on CBLHD26-ASM is meant only for programming from the SMI
software; it is not recommended for running the motor.

As shown in the pinout diagram (see page 35), the HD26 connector has pins available to support a USB
connector attached to the end of a cable from those leads. When that is installed, a USB port on the
host computer can be used to communicate directly with the SmartMotor without need for a USB to
serial adapter. The SMI software provides direct support for that communication method. However, the
USB connection is meant for programming only and is not recommended for running the motor.

The CBLHD26INT connector (see the next figure) incorporates a Micro USB port for direct connection
of a customer-supplied USB cable along with a 120 ohm terminating resistor, in the form of a jumper
located under the cover, that can be switched in/out as needed.

CBLHD26-ASM

Connector assembly from Moog Animatics; 

cable is customer supplied

USB A Male to Micro USB

(Customer supplied)

B

Jumper TERM*

(under cover)

*When ON, activates 

120 ohm terminator

CAN bus

USB Connection to HD26 Cable

Dual Power Configuration
The dual power configuration, a standard feature on the Class 6 D-style motor, allows the controller
and drive amplifier to be powered from either a single or two separate DC power supplies. It is highly
recommended to use the dual power configuration.
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Dual Power Configuration

Drive

Controller

SmartMotor

Power 
Supply

 11   10    
   9

7W2

D-sub

Drive

Controller

SmartMotor

Power 
Supply

 11   10    
   9

7W2

D-sub
Power 
Supply

Single Power Supply Dual Power Supplies
Powers Drive and Controller Maintains Controller if Drive Power is Cut

Dual

Single

Single vs. Dual Power Configuration

NOTE: For the Class 6 D-style motor, if only one power supply connection is used, it must be
through the Drive Power input, pins A1 and A2, on the 7W2 connector, which will also internally
supply power to the motor's controller. User outputs will not operate, but inputs will operate. When
separate power supplies are used, internal circuitry prevents their positive rails from shorting
together.

 11   10    
   9

A1 A2
1  2

3 4 5

 26 

 

 

1  

Drive Amp Power Supply:

48 VDC**

DRIVE PWR GND

DRIVE PWR

Control Power Supply:

24 VDC**

CONTROL PWR GND

CONTROL PWR

CN2: 26-PIN D-SUB

PIN# NAME

1

10

11

13

12 CONTROL PWR GND

26

CONTROL PWR

CN1: 7-PIN COMBO

PIN# NAME

5 SIG GND

1 CAN LOW

2 CAN HIGH

3 RS-232 TRANSMIT

4 RS-232 RECEIVE

A1

DRIVE PWR GNDA2

DRIVE PWR

+

−

+

−

K

E-Stop

Switch

T*

T*

L1

L2
AC DC

KT

24 VDC

GND

NOTES:

 * Could be cascaded relays without timer

** Typical DC voltage levels

Shunt

Protective shunt should be placed between E-stop and motor drive power 
input to suppress Back EMF.

Optional shorting of motor input on dropped drive power provides the most 
protection against Back EMF, and unintended freewheel motion, by employ-
ing dynamic braking to stop the motor.

Relay T is time-delay open; relay K is immediate open; relay K must close 
before relay T to avoid any damage to relay K from SmartMotor in-rush currents.

This circuit is recommended for smoother startup of large switch-mode sup-
plies where surge currents may cause noise issues.

NOTE: All Class 6 D-style SmartMotors are designed to allow the use of separate drive and control
power supplies. No special ordering option is needed for those SmartMotors.
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CDS Schematic

CDS Schematic
This section provides schematics for wiring a Class 6 D-style SmartMotor through the CDS CAN
connection.

NOTE: CDS and CDS7 are included on all Class 6 D-style SmartMotor products.

CDS on the HD26 Connector

As a standard feature, the Class 6 D-style SmartMotor provides a CDS CAN connection allowing CAN
bus network wiring through the HD26 connector (26-pin D-sub I/O connector shown in the next figure).
This eliminates a CAN connector on the back of the motor, leaving it free for other purposes, like the
dual-port Industrial Ethernet option. The D-style motor with the CDS CAN connection can be used as
the terminating node. To enable this, a 120 ohm terminating resistor (shunt) must be placed across pins
13 and 14. For details, see the next figure.

NOTE: Terminating resistors (shunts) must always be used at both ends of a CAN bus network.

Motor as Terminating Node
I/O Connector

Pin Numbers

Trajectory
LED (Bt)

Power/Servo
LED

120 Ohm Terminator Shield Drain

17 CAN High

18 CAN Low

17

18

CAN High

CAN Low

PIN DESCRIPTION

All other pins are as 

previously shown.

18 CAN Low

17 CAN High

12 Shield Drain

120 Ohm

Terminator
120 Ohm

Terminator

HD26-Pin D-Sub I/O

2
6

-p
in

 D
-s

u
b

 M
a

le

1

17
18

26

26-pin D-sub Male

1 1
7

1
8

2
6

26-pin D-sub Male

1 1
7

1
8

2
6

26-pin D-sub Male

1 1
7

1
8

2
6

1
2

  26   25  24   23   22   21  20  19

   9      8      7     6      5      4     3      2     1  Top row:

   18    17   16   15   14    13   12    11   1 0 Mid row:

Btm row:

1 

NOTE: A terminating resistor (shunt) or pass-thru terminator is required at each end of the bus.
Bus must be multi-drop as shown, not a star network. 24V CAN bus power connection is not
required at the motor.

Schematic for CDS Option, D-Style SmartMotor Used as Terminating Node

CDS on the 7W2 Connector (CDS7)

Alternatively, CDS7 on the Class 6 D-style SmartMotor allows CDS to be wired through pins 1 and 2 of
the 7-pin D-Sub (7W2) connector as shown in the next figure. The wiring is accomplished through the
use of a single Add-A-Motor cable that carries Power, RS-232, and CAN bus to the next motor in the
chain. This method allows pins 13 and 14 on the 26-pin D-sub connector to be used as an easy
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CDS on the 7W2 Connector (CDS7)

terminating point on the last motor by simply placing a 120 Ohm terminating resistor (shunt) across
those pins OR installing the Pass-Thru Terminator on that connector.

This design not only greatly simplifies motor installation, but also does the same for CAN bus
addressing. With CDS7, the SmartMotor is the first and only single-cable, point-to-point integrated
motor to have both motor-to-motor full communications and control capability, and only single-cable,
point-to-point for both power and communications in general.

As a result:
l When you order the Class 6 D-style SmartMotors and CDS7 Add-A-Motor cables, you get
prewired, instant, full-network capability, and those networked motors are auto-detectable
directly from SMI.

l This allows for auto-addressing and ease of reconnection at the next power up.

l Unlike competitive CANopen devices, the CDS7 SmartMotors do not require single-node power
up to set addresses. You can power up all at once, have SMI detect them and set all motor CAN
bus addresses in a single line of code. For details, see Detecting and Communicating with the
SmartMotors on page 47.

CDS7 is fully backward compatible with the wiring method described in the previous section. Therefore,
all Class 6 D-style SmartMotors can be wired either through the D-sub connector or the 7W2
connector.

When the SmartMotor is a terminating node on the CAN bus, the 120 Ohm terminating resistor (shunt)
must be wired to pins 13 and 14 of the 26-pin D-sub connector. A 120 Ohm terminating resistor (shunt)
is also required at the beginning of the CAN bus. See the next figures.

For further convenience, a 26-pin pass-through D-sub connector (Pass-Thru Terminator, PN: CBLSM-
TR120) is available that contains a built-in 120 Ohm terminating resistor (shunt). When a SmartMotor
is the terminating node and the 7W2 wiring method is used (described previously), you can simply
install the pass-through connector on the SmartMotor's 26-pin D-sub connector to serve as the
terminator.
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CDS on the 7W2 Connector (CDS7)

Motor as 

Terminating Node

Trajectory
LED (Bt)

Power/Servo
LED

7W2 D-sub Female 7W2 D-sub Female 7W2 D-sub Female

2
6

-p
in

 D
-s

u
b

 M
a

le

1

17
18

26

1 2 3 4 5

1 CAN Low

2 CAN High

5 Shield Drain

11   10   
   9

A1 A2
1 2

3 4 5

1 2 3 4 5 1 2 3 4 5

A1 A2 A1 A2 A1 A2

120 Ohm Terminator

at Bus Controller

(PLC, Host, HMI)

7W2 D-sub Conn.

Pin Numbers

1

2

CAN Low

CAN High

PIN DESCRIPTION

All other pins are as previously 

shown. See the D-Style Con-

nector Pinouts table later in 

this guide for full details.

120 Ohm Terminator
26-Pin D-sub

Connector

17

18

CAN High

CAN Low

PIN DESCRIPTION

All other pins are as previously 

shown. See the D-Style Con-

nector Pinouts table later in 

this guide for full details.

CAN Low

CAN High

CAN Low

CAN High

OR 

Incoming CAN on 

26-pin connector 

(NO incoming CAN 

leads on the 7W2)

Incoming CAN on 

7W2 connector

120 Ohm

Terminator

17

18

When motor is an end 

node on CAN bus, install 

this on the 26-pin D-sub:
120 Ohm

Terminator

26-pin D-sub Male

1 1
7

1
8

2
6

1 

1 

NOTE: A terminating resistor (shunt) or pass-thru terminator is required at each end of the bus.
Bus must be multi-drop as shown, not a star network. 24V CAN bus power connection is not
required at the motor.

Schematic for CDS7 Option, D-Style SmartMotor Used as Terminating Node

For the above methods, the incoming CAN bus signal is connected to the 7W2 connector OR the 26-pin
connector, and the CDS Add-A-Motor cable (PN: CBLSMCDS-xM) will automatically provide CAN bus,
RS-232 and power wiring in one cable between motors.

The next figure shows how factory cables are used to attach the incoming power and RS-232
communications to the 7W2 connector, and incoming CAN bus signal to the 7W2 connector OR the
26-pin connector (each method requires different cables).
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CDS on the 7W2 Connector (CDS7)

CBLSMCDS-xM

120 Ohm

Terminator

17

18

When motor is an end 

node on CAN bus, install 

this on the 26-pin D-sub:

Note BLUE connectors 

that differentiate the 

CDS7 cables from 

standard Add-A-Motor 

cables.

Incoming CAN on

26-Pin D-sub

There must be NO 

incoming CAN wires 

on the 7W2 connector.

Incoming RS-232

Incoming Power

CBLSM1-xM

If motor is end node, 
put jumper TERM
ON (under cover) 
to activate 120 ohm 

terminator 

Connector shell is from Moog Animatics; 

cable is customer supplied

Use CBLHD26-ASM with 

jumper TERM ON

OR

CBLHD26-ASM 

Incoming Power

Incoming RS-232

Incoming CAN on

7W2 Connector

120 Ohm

Terminator

CBLPWRCOM3-xM

OR

NOTE: A terminating resistor (shunt) or pass-thru terminator is required at each end of the bus.
Bus must be multi-drop as shown, not a star network. 24V CAN bus power connection is not
required at the motor.

CDS7 Option Cabling Diagram

Refer to these tables for part numbers and cable lengths:

CDS7
Cable PN

Length
(Meters)

Power/Com
Cable PN

Length
(Meters)

CBLSMCDS-0.3M 0.3 CBLPWRCOM3-xM* 3-10
CBLSMCDS-0.9M 0.9 CBLSM1-xM** 3-10
CBLSMCDS-3.0M 3.0 CBLHD26-ASM**

CBLSMCDS-7.5M 7.5
CAUTION: As noted by the BLUE con-
nectors, these are NOT the same as the
Add-A-Motor cables shown on page 37, and
they are NOT interchangeable.

*Recommended method
**Optional method

See the cable data on the website or consult the factory for the schematic diagrams.

For PN: CBLHD26-ASM, see Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM).
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Industrial Ethernet Network

Industrial Ethernet Network
NOTE:   If you have set your PC's network adapter to a fixed IP address for temporary connections
to SmartMotors with SMI, remember to return it to DHCP when done to avoid local area network
connectivity issues.

The Industrial Ethernet network is used for the EtherCAT (-EEC), EtherNet/IP (-EIP) and PROFINET
(-EPN) options. Most Industrial Ethernet (IE) networks support line, tree or star device-connection
topology. Tree or star network may require switches/hubs designed for that network type.
Requirements for specific configurations depend on the capabilities of the controller device, the
follower devices, and use of other networking equipment. For more details, refer to the corresponding
SmartMotor fieldbus manual.

CAUTION: To minimize the possibility of electromagnetic interference (EMI), all
connections should use shielded Ethernet Category 5 (Cat 5), or better, cables.

The next diagram shows an example Industrial Ethernet network with the SmartMotors daisy chained
to the controller device. A "ring" configuration can be created if the controller device has two ports.

CAUTION: When daisy-chaining SmartMotors for an EtherCAT network, you must
connect the OUT port of the upstream motor to the IN port of the downstream
motor. Refer to the Ethernet ports labeling on your SmartMotor.

IN*OUT* IN*OUT*

Other follower device:

- I/O block,

- Servo drive,

- etc.

Controller device:

- PC,

- PLC,

- etc.

Optional ring for cable redundancy**

*IN/OUT applies only to EtherCAT networks. Refer to the previous CAUTION and motor labeling.

**Ring con�guration requires a controller device with two ports

Industrial Ethernet Network

* *

*

*

*

*

* *

NOTE: Unlike other fieldbus protocols, EtherCAT does not require terminators at each end of the
network bus.
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Maximum Cable Length

Maximum Cable Length

For transmission speeds of 100 Megabits/second on shielded Ethernet Cat 5 cable, most Industrial
Ethernet networks allow cable lengths up to 100 meters between network nodes. For more details,
refer to the corresponding SmartMotor fieldbus manual.

Ethernet Cables

For the Class 6 D-style SmartMotor with the Industrial Ethernet option, no special cables are required.
That option adds a dual-port switch with 2 standard RJ45 connectors on the back of the motor. Those
allow connection to your network, and also daisy chaining between motors using standard (not-
crossover), off-the-shelf Cat 5 or better Ethernet cables, which are available from consumer electronics
and computer supply stores.

NOTE: A crossover cable is not required. The Industrial Ethernet ports include an "auto-crossover"
feature that will engage as needed.
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Understanding the Status LEDs

Understanding the Status LEDs
The section describes the functionality of the status LEDs on the Class 6 D-style SmartMotors.

  

Refer to the corresponding SmartMotor 
fieldbus guide

Refer to the corresponding SmartMotor 
fieldbus guide

Refer to the corresponding SmartMotor 
fieldbus guide

Refer to the corresponding SmartMotor 
fieldbus guide

LED 3: (Network specific) LED

LED 6/7: Link & Activity LED

LED 2: (Network specific) LED

LED 4/5: Link & Activity LED

Industrial Ethernet Option Industrial Ethernet Option

Flickering = On/Off in 0.1 sec; Blinking = On/Off in 0.5 sec; Flashing = separated by 1 sec for EtherCAT LEDs and 2 sec for Fault Codes

 Off  No power

 Solid green Drive on

 Blinking green  Drive off, no faults

 Triple red flash Watchdog fault

 Solid red  Faulted or no drive enable input

 Off  Not busy
 Solid green Drive on, trajectory in progress

 

 
 

 

Flashing # red Flashes fault code** (see below) 
when Drive LED is solid red

LED 0: Power/Servo LED LED 1: Trajectory LED

LED Status on Power-up:
• With no program and the travel limit inputs are low:

LED 0 solid red; motor is in fault state due to travel limit fault     

LED 1 off

• With no program and the travel limits are high:
LED 0 solid red for 500 milliseconds then flashing green 

LED 1 off

• With a program that only disables travel limits: 

LED 0 red for 500 milliseconds then flashing green 

LED 1 off

Flash
1
2
3
4
5
6
7
8
9

10
11

Description
NOT Used
Bus Voltage
Over Current
Excessive Temperature
Excessive Position
Velocity Limit
dE/Dt - First derivative of position error is excessive
Hardware Positive Limit Reached
Hardware Negative Limit Reached
Software Positive Travel Limit Reached
Software Negative Travel Limit Reached 

LED 1 Fault Codes: 

**Busy LED pauses for 2 seconds before flashing the code

Alt. red/green* In boot load; needs firmware

*If the USB port is plugged in at power up, it flashes for ~4 
seconds, turns solid red until it is detected through SMI, then 
it returns to flashing

  

LED 0 (Power/Servo Status) 

LED 1 (Trajectory
Status / CAN Error) 

LED 3 (Network specific) LED 

LED 2 (Network specific) LED

LED 4/5 Link & Activity LEDs 

LED 6/7 Link & Activity LEDs 

Industrial Ethernet Option
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Detecting and Communicating with the SmartMotors

Detecting and Communicating with the SmartMotors
NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

This section describes how to detect and address the Class 6 SmartMotor.

This procedure assumes that:
l The SmartMotor is connected to the computer.

l The SmartMotor is connected to a power source.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 26.

Understanding the Detection and Configuration Options
NOTE: This feature requires connection to the serial (COM) port, configured as RS-232 or RS-485.

There are several ways to use the SMI software to find and address the Class 6 D-style SmartMotors
that are connected to your PC:

l Use the Find Motors button—this method is recommended for first-time communications or
when you don't know the port used to connect the motors. For details, see Using the Find Motors
Button on page 47.

l Use the Detect Motors feature—this method can be used if you know the communications port
used to connect your motors and if your motors may be pre-addressed. For details, see Using the
Detect Motors Feature on page 50.

Several of these methods are described in the next sections.

Using the Find Motors Button
The easiest way to locate any connected SmartMotor is to use the Find Motors button (see the next
figure). This method searches all ports on the PC for connected motors.

To begin searching for motors on the PC, in the Configuration window of the SMI software interface,
click Find Motors. The SMI software begins searching for all SmartMotors connected to the PC.

NOTE: The next figures show examples for an RS-232 SmartMotor. To see similar example figures
for USB motors, refer to Using the Detect Motors Feature on page 50.
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Using the Find Motors Button

Find Motors Detecting SmartMotors on the RS-232 Chain

After the process has completed, the SMI software shows the found motors in the Configuration
window under the corresponding communications port. Each motor is represented by a motor icon; the
motor's address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Detected RS-232 SmartMotor

To address the motor, right-click on the motor and select Set Motor Address. For more details, see the
SMI Software Help, which can be accessed within SMI by pressing F1 or from the Help menu.
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Using the Find Motors Button

Motor Menu - Set Motor Address

The motor's detailed information can be viewed in the Motor View window, which is accessed by
selecting the Tools > Motor View > Info tab.

Motor View Information Tab

Moog Animatics Class 6 D-Style SmartMotor™ Installation and Startup Guide, Rev. D

Page 49 of 72



Using the Detect Motors Feature

Using the Detect Motors Feature
This method is similar to the Find Motors method, but it searches only the specified communications
port for connected SmartMotors. This is also the recommended method for detecting Class 6 D-style
motors after they have been pre-addressed and daisy-chained to the communications port.

To use the Detect Motors feature, in the Configuration window of the SMI software, right-click the
desired communications port and select Detect Motors from the menu.

Selecting the Detect Motors Feature

The SMI software begins searching for all SmartMotors connected to the specified communications
port. A progress bar is shown while the SMI software searches for the motors.

After the process has completed, the SMI software shows the found motors in the Configuration
window under the corresponding communications port. Each motor is represented by a motor icon; the
motor's address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Detected SmartMotor

To address the motor, right-click on the motor and select Set Motor Address. For more details, see the
SMI Software Help, which can be accessed within SMI by pressing F1 or from the Help menu.
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Using the Detect Motors Feature

Motor Menu - Set Motor Address

The motor's detailed information can be viewed in the Motor View window, which is accessed by
selecting the Tools > Motor View > Info tab.

Motor View Information
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Checking and Clearing the Status Bits

Checking and Clearing the Status Bits
NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The Motor View window is used to view and monitor various motor parameters. It is used in conjunction
with the Terminal window to clear any active overtravel limits.

This procedure assumes that:
l The SmartMotor is connected to the computer.

l The SmartMotor is connected to a power source.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 26.

l The SmartMotor has been detected and addressed.
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Polling the Motor

Polling the Motor
To view the current state of the status bits, you must poll the motor.

1. Double-click the motor icon to open the Motor View window (see the next figure).

2. Click the Poll button to begin polling data from the motor.

Motor View

A SmartMotor with no program and no I/O connections will boot up with active overtravel limits (see
the red status bits numbered 10 through 15 in the previous figure).
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Clearing the Overtravel Limits and Fault Bits

Clearing the Overtravel Limits and Fault Bits
To disable (clear) the overtravel limits, enter EIGN(2) and EIGN(3) in the SMI software Terminal
window. This sets I/O 2 (positive overtravel limit) and I/O 3 (negative overtravel limit) as general
inputs/outputs instead of being used as travel limits. To set all status bits in Word 0 as general
inputs/outputs, enter EIGN(W,0).

NOTE: You can either type the command in the white text box or type the command directly in the
blue area of the terminal screen and then click Send or press Enter.

The active and asserted bits are cleared, as shown in the next figures.

EIGN Command Entered Active and Asserted Bits Cleared

To clear the historical fault bits, enter ZS. All remaining fault bits are cleared, as shown in the next
figures.

ZS Command Entered Remaining Bits Cleared
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Moving the SmartMotor

Moving the SmartMotor
NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The SMI software contains a Torque mode that is used to test the motor response and ensure the drive
is operating properly.

This procedure assumes that:
l The SmartMotor is connected to the computer.

l The SmartMotor is connected to a power source.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 26.

l The SmartMotor has been detected and addressed.

l The fault bits have been cleared. For details, see Checking and Clearing the Status Bits on page
52.

Making the Motor Move

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be
considered in the workcell design (see Other Safety Considerations on page 9).

To make the SmartMotor move:

1. In the Terminal window, select the tab that matches the communications channel to which your
motors are connected. To do this, look at the Configuration window, find the channel where the
motors are listed and click that tab name in the Terminal window.

Tab Selected that Matches the Communications Channel

NOTE: If you do not have the correct tab selected, the commands you enter will not go to the
motors and there will be no response.
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Setting and Reporting Torque

2. Enter these commands in the Terminal window:

You should immediately see the motor shaft moving in the positive direction (clockwise, when
looking at the end of the motor shaft). If the motor does not respond to the commands, see
Troubleshooting on page 70 for troubleshooting tips.

NOTE: Macros (shortcut keys) can be used to simplify entry of frequently-used commands.
For details, see Macros in the SmartMotor™ Developer's Guide.

3. After you have observed the motor shaft turning, enter the X command to decelerate the motor
to a stop.

Setting and Reporting Torque
The commands in this section are related to the previous motion procedure. For more details on these
commands, see the SmartMotor™ Developer's Guide.

MT (Mode Torque)

MT sets the mode of operation to torque mode. In this mode, the SmartMotor shaft applies a torque
independent of position. For more details, see Torque Mode in the SmartMotor™ Developer's Guide.

T=formula (Set Target Torque)

T can be set to any value from -32767 to +32767, which represents -99.99% to +99.99% PWM (pulse-
width modulation) commanded.

RTRQ (Report Actual Torque)

Enter RTRQ at the Terminal window to report the commanded torque from the trajectory generator.

Note that RTRQ typically reports a value that's one less than the T value. In the previous example,
T=3000, but RTRQ reports 2999. The value returned by TRQ (and RTRQ) will typically be one less than
the T (torque) value due to internal calculations. It may also be reduced in cases where the motor’s
output is in limitation. TRQ represents the output effort of the motor in both MT (torque mode) and
servo modes (MV, MP, etc.). Therefore, it provides a seamless transfer across those modes without
causing a ripple or bump in force to the load.

TS (Set Torque Slope)

The TS command defines how fast the processor applies a change in torque. For an example of the
TS command, see the Chart View Example in the SmartMotor™ Developer's Guide.

Torque slope can range from -1 to 2147483647 (default). At a value of 65536, the processor changes
torque by a value of 1 for each PID sample. The default sample rate is 16000; you can view the current
sample rate with the RSAMP command.

Moog Animatics Class 6 D-Style SmartMotor™ Installation and Startup Guide, Rev. D

Page 56 of 72

http://www.animatics.com/smartmotor-developers-guide
http://www.animatics.com/smartmotor-developers-guide
http://www.animatics.com/smartmotor-developers-guide
http://www.animatics.com/smartmotor-developers-guide


Checking the Motor Position

NOTE: If you're moving from a Class 5 to a Class 6 SmartMotor, the faster Class 6 sample rate
means the torque slope operates twice as fast in real-world time.

Checking the Motor Position
There are several ways to check the motor position:

l Report the position using commands from the Terminal window

l View the position in the Motor View tool

These two methods are described in the next sections. You can also view the position in the Monitor or
Chart View software tools. For details, see SMI Software Features in the SmartMotor™ Developer's
Guide.

This procedure assumes that:
l The SmartMotor is connected to the computer.

l The SmartMotor is connected to a power source.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 26.

l The SmartMotor has been detected and addressed.

l The fault bits have been cleared. For details, see Checking and Clearing the Status Bits on page
52.

Viewing the Motor Position with a Report Command
To report the motor position, in the Terminal window, issue the RPA (Report Position Actual) command:

RPA

The terminal responds with the current position of the motor:

RPA 3593657

NOTE: The position is reported on the same line as the command; there is no line feed or carriage
return for "report" commands.

The RPA command reports the actual motor position at the time the command was issued. Therefore, it
is just a "snapshot"—if the motor is moving, the reported position is not dynamically updated.

Viewing the Motor Position with the Motor View Tool
The Motor View tool provides another way to view the motor position. The advantage of using this tool
is that the position is dynamically updated when the motor is moving.

Moog Animatics Class 6 D-Style SmartMotor™ Installation and Startup Guide, Rev. D

Page 57 of 72

http://www.animatics.com/smartmotor-developers-guide
http://www.animatics.com/smartmotor-developers-guide


Viewing the Motor Position with the Motor View Tool

To open the Motor View tool, from the SMI software Configuration window, right-click the motor you
want to view and select Motor View from the menu.

Opening the Motor View Tool

After the Motor View window opens, click the Poll button to begin polling (getting information from)
the motor. After polling begins, the motor position is shown in the Position box.

Motor View Tool Showing the Motor Position
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Connectors, Pinouts and Examples

Connectors, Pinouts and Examples
This chapter provides information on the SmartMotor connector pinouts and specifications. It also
provides example I/O connection diagrams. For information on connecting the motors, see .

Class 6 D-Style Connector Pinouts 60

Class 6 D-Style I/O Connection Examples 61

Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM) 63
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Class 6 D-Style Connector Pinouts

Class 6 D-Style Connector Pinouts
This table shows the pinouts for the connectors on the Class 6 D-style SmartMotors.

PIN MAIN POWER P1
1

7W2 Combo
D-Sub Connector2

3 RS-232 Transmit (COM CH 0)
4 RS-232 Receive (COM CH 0)
5 SIG Ground
A1 Main Power
A2 Common Ground (req’d. POWER Ground)

PIN I/O CONNECTOR (5V TTL I/O) P2
1 IN0 GP, also Analog Input
2 IN1 GP, also Analog Input
3 IN2 Positive Limit or GP

4 IN3 Negative Limit or GP

5 IN/OUT4 GP or Ext. Enc. Index Capture

6 IN/OUT5 GP or Int. Enc. Index Capture

7 IN6 GP, G Command or Homing Input
8 IN7 Drive Enable Input (Dedicated)
9 IN/OUT8 GP or Brake Line Output
10 IN/OUT9 GP or Not Fault Output
11 +24 VDC Control Power +24 V logic I/O, 

range 18 - 32 V max
12 Control Power Return (Ground, Common) Ground Reference
13
14
15

Encoder A+ Input

11   10   
   9

A1 A2
1 2

3 4 5

Notes:

Notes:

CAUTION: DO NOT exceed the specified voltage limits, 
as this may cause immediate damage to the internal 
electronics, which will void the warranty.

CAUTION: Pins 11 and 12 are intended as an input for 
control/IO power only. DO NOT attempt to use those 
pins for main servo-drive power, as this may result in 
immediate damage to the electronics, which will void 
the warranty.

Must be Main Power Ground

Specifications:

Specifications:

16

Encoder A– Input

17

Encoder B+ Input

18

Encoder B– Input

19 RS-485 B (COM CH 1)
20 RS-485 A (COM CH 1)
21

USB +5 V Bus

22

Ground, Common

23
USB D+24
USB D-25

4 - 20 mA Send

26

Pin Main Power P1

Pin HD26 Connector (24 V Sourcing I/O) P2Notes:

Notes:

Specifications:

Specifications:

4 - 20 mA Return

1.5 MHz max as Enc or 
Step input

Nonisolated

1 Mbit/sec Max

115.2 KBaud Max

Also supplies I/O;
do not exceed 32 V max

Redundant to 7W2
connector

NOTE: Optional dual-port Ethernet connectors (not shown above) are industry standard RJ45 and compatible with 
off-the-shelf Cat 5 or better cables available at any consumer electronics or computer supply store.

Redundant to HD26 
connector

For Outputs: Do not exceed
200 mAmps source each or
400 mAmps combined

For Inputs: 9 Configurable 

Low Lvl Thld: 3.6 V Max 

High Lvl Thld: 6.0 V Min 
Analog Input Scale: 10 V FS  

and 1 Dedicated

Inp Impedance > 10 Kohm

CAN High
CAN Low

P1 7-Pin Combo
D-Sub Power 
& I/O

P2 26-Pin 
D-Sub I/O

1 Mbit/sec Max

115.2 KBaud Max

Nonisolated

 +24-48 VDC See NOTE

NOTE: These motors can operate on power down to +20 VDC, but it is not recommended due to greatly reduced performance —
optimum performance is achieved at 48 VDC.

Trajectory

LED

PWR/Servo 

LED

1

NOTE: All specifications are subject to change without notice. Consult the factory for the latest information.

For programming from SMI, 
not recommended for 
running the motor

Optional Dual-Port Industrial Ethernet
*IN/OUT applies only to EtherCAT networks

IN*OUT*

CAN High

CAN Low

HD26-Pin D-Sub I/O

  26   25  24   23   22   21  20  19

   9      8      7     6      5      4     3      2     1  Top row:

   18    17   16   15   14    13   12    11   1 0 Mid row:

Btm row:

1 

For details on the P2 (HD26) cable, see Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM).
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Class 6 D-Style I/O Connection Examples

Class 6 D-Style I/O Connection Examples
This section shows I/O connection examples for the Class 6 D-style motors. Also, refer to Class 6 D-
Style Connector Pinouts on page 60 for connector specifications.

4

IN-2

IN-3

Pos / Right Limit (Dry Switch)

Neg / Left Limit (Dry Switch)

3

2

5

IN-1

IN-4

24 VDC 

User Supplied

Momentary Switch

PNP

Sense

PNP Switch

HD26-Pin D-Sub I/O

  26   25  24   23   22   21  20  19  

   9      8      7     6      5      4     3      2     1  Top row:

   18    17   16   15   14    13   12    11   1 0 Mid row:

Btm row:

1 

Encoder A+ input

14

15

CAN Low  (also on 7W2)

16

17

18

19

20

21

22

23

24

25

26

RS-485 B (COM CH 1)

RS-485 A (COM CH 1)

4-20 mA Send

4-20 mA Return

PIN DESCRIPTION

Encoder A– input

Encoder B+ input

Encoder B– input

USB 5 V Bus

USB D+

USB D–

Ground (Common)

1

2

3

4

5

6

7

8

9

10

11

12

13

IN0 GP, also Analog input

IN1 GP, also Analog input

IN2 Positive Limit or GP

IN3 Negative Limit or GP

IN/OUT4 GP

IN/OUT5 GP

IN6, G cmd, Home in

PIN DESCRIPTION

CAN High (also on 7W2)

Ground (Common)

+24 VDC Control Power

IN7, Drive Enable input

IN/OUT8, GP or Brake out

IN/OUT9, GP or Not Fault out

NOTE: I/O is Sourcing type (PNP)Switches and PNP Sensor

NOTE: I/O is Sourcing type (PNP)

4

3

2

5

6

7

8

9

10

24 VDC
User supplied

12 Ground

1

–  LOAD +

+

–

+

–

Analog Output 

Sensor

Analog

Potentiometer

Class 6 D-Style Analog Pot and Sensor

Output

Input

Input

Input

Input

Encoder A+ input

1

2

3

4

5

6

7

8

9

10

11

12

13

IN0 GP, also Analog input

IN1 GP, also Analog input

IN2 Positive Limit or GP

IN3 Negative Limit or GP

IN/OUT4 GP

IN/OUT5 GP

IN6, G cmd, Home in

PIN DESCRIPTION

Ground (Common)

+24 VDC Control Power

IN7, Drive Enable input

IN/OUT8, GP or Brake out

IN/OUT9, GP or Not Fault out

14

15

CAN Low  (also on 7W2)

16

17

18

19

20

21

22

23

24

25

26

RS-485 B (COM CH 1)

RS-485 A (COM CH 1)

4-20 mA Send

4-20 mA Return

PIN DESCRIPTION

Encoder A– input

Encoder B+ input

Encoder B– input

USB 5 V Bus

USB D+

USB D–

Ground (Common)

CAN High (also on 7W2)

NOTES:
I/O TYPE

The Class 6 D-style motor I/O is Sourcing type (PNP).

DRIVE ENABLE

The Drive Enable input (pin 8) must be satisfied in order for the motor to turn.
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Class 6 D-Style I/O Connection Examples

24 VOLTS DC POWER

Pin 11 is not a source for 24 VDC power; it is an input only.
l I/O devices must be sourced from an external power supply.

l Loads on specific outputs are allowed (when within the described limits).

ANALOG INPUTS
l Analog input reading will be saturated at 10 VDC, although the control power level can go up to
24 VDC. In other words, if you place an analog voltage into it, and it went from 0 to 24 VDC, the
reading will max out at 10 VDC, even though the input voltage keeps rising.

DIFFERENTIAL ENCODER

The Differential Encoder inputs use the standard RS-485 chipset:
l If a true differential output TTL encoder is used, just wire A and B signals as labeled.

CAUTION: NO differential encoder signals higher than 5V TTL should be used!
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Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM)

Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM)
Part CBLHD26-ASM is available so that users can construct their own interface cable for the Class 6 D-
style SmartMotor. The connector (with customer-supplied cable) attaches to the HD26 D-sub connector
on the motor. The figure and table show the PCB connection points for the cable.

PIN I/O CONNECTOR (5V TTL I/O)
1 IN0 GP, also Analog Input
2 IN1 GP, also Analog Input
3 IN2 Positive Limit or GP

4 IN3 Negative Limit or GP

5 IN/OUT4 GP or Ext. Enc. Index Capture

6 IN/OUT5 GP or Int. Enc. Index Capture

7 IN6 GP, G Command or Homing Input
8 IN7 Drive Enable Input (Dedicated)
9 IN/OUT8 GP or Brake Line Output
10 IN/OUT9 GP or Not Fault Output
11 +24 VDC Control Power +24 V logic I/O; 

range 18 - 32 V Max

12 Control Power Return (Ground, Common) Ground Reference
13
14
15

Encoder A+ Input

Notes:

NOTE: All specifications are subject to change without notice. Consult the factory for the latest information.

CAUTION: DO NOT exceed the specified voltage limits, as this may cause immediate damage to the internal 
electronics, which will void the warranty.

Specifications:

16

Encoder A– Input

17

Encoder B+ Input

18

Encoder B– Input

19 RS-485 B (COM CH 1)
20 RS-485 A (COM CH 1)
21

USB +5 V Bus

22

Ground, Common

23
USB D+24
USB D-25

4 - 20 mA Send

26

Pin       PCB       AWG HD26 Connector (24 V Sourcing I/O) Notes:Specifications:

4 - 20 mA Return

1.5 MHz max as Enc or 
Step input

Nonisolated

1 Mbit/sec Max

115.2 KBaud Max

Also supplies I/O;
do not exceed 32 V max

Redundant to 7W2
connector

For Outputs: Do not exceed
200 mAmps source each or
400 mAmps combined

For Inputs: 9 Configurable 

Low Lvl Thld: 3.6 V Max 

High Lvl Thld: 6.0 V Min 
Analog Input Scale: 10 V FS  

and 1 Dedicated

Inp Impedance > 10 Kohm

CAN High
CAN Low

Nonisolated

For the USB  connector on 
PCB; used to program from
SMI, not recommended for 
running the motor

Additional ground points
ShieldSH

CAUTION: Pins 11 and 12 are intended as an input for control/IO power only. DO NOT attempt to use those pins for 
main servo-drive power, as this may result in immediate damage to the electronics, which will void the warranty.

26

18

26

18

26

NOTE: All wiring should be twisted pairs unless otherwise noted. Cable should be shielded with spiral wrap alumi-
nized tape and a .5 mm2 drain wire of stranded tinned copper. Consult the factory for the more information.

——
——

——
——

I0

I1

I2

I3

IO4

IO5

I6

I7

IO8

IO9

24V

RTN

A+

A–

B+

B–

C_P

C_N

RS485B

RS485A

4-20S

4-20R

Ground, CommonRTN

ON = terminatedJumper - CAN 120 Ohm TerminatorCAN TERM

USB
Conn.

Cover removed to show internal PCBPN: CBLHD26-ASM
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Other Class 6 D-Style Changes

Other Class 6 D-Style Changes
This chapter provides information on getting started with your SmartMotor.

Batteryless Absolute Multiturn Encoder 65

Absolute Encoder Control Commands 65

EOBK(IO) Command Limitations 65

EOFT(IO) Command Limitations 65

Ethernet Error, Status Word 2 Bit 6 66

I/O Control Details 66

I/O Control Examples 67

Scale Factor Calculation – Sample Rates 67

Commands for Class 6 68

Commands That Have Changed 69

Commands Not Supported 69

Commands Supporting the DS2020 Combitronic System 69

Features not Available in Class 6 D-Style 69
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Batteryless Absolute Multiturn Encoder

Batteryless Absolute Multiturn Encoder
The batteryless absolute multiturn encoder is a standard feature on every Class 6 D-style SmartMotor.
It is a magnetic absolute multiturn encoder that requires NO backup battery. Its internal circuitry
allows the motor to retain the absolute encoder position and allows continued multiturn position
tracking when main power is removed from the motor. This provides the benefits of no rehoming and
minimized downtime when main power is removed due to an emergency stop, power outage or other
cause.

Absolute Encoder Control Commands
This section describes the batteryless absolute multiturn encoder control commands that are available
for the Class 6 D-style SmartMotor. For more details on these commands, see the SmartMotor™
Developer's Guide.

CAUTION: Use of the O= or OSH= command will confuse the absolute position
information. Therefore, do not use these commands. Instead, use the ENCCTL
command (described in this section).

ENCCTL(-1,x) removes the effect of the ENCCTL(0,x) command — the PA offset is then set as shipped
from factory.

x can be any value.

ENCCTL(0,x) sets the absolute position to x, offset is nonvolatile and maintained in the SmartMotor’s
EEPROM memory. At power-up, the motor's firmware will adjust absolute position with offset.

0 is the command; x is the desired position at the time the instruction is executed and is a signed
32-bit integer.

ENCCTL(11,x) selection of encoder resolution relative to 12-bit (4096 counts per revolution). Positive
value increases resolution as a bit shift by that value; negative value decreases resolution as a bit shift
by that value.

x can be from -2 to 2.

EOBK(IO) Command Limitations
The EOBK(IO) command configures the specified SmartMotor output to control an external brake.
However, only output 8 works for the Class 6 D-style SmartMotor. Therefore, the valid EOBK(IO) values
are:

l EOBK(8) to enable

l EOBK(-1) to disable

EOFT(IO) Command Limitations
The EOFT(IO) command configures the specified SmartMotor output to the fault indication. However,
only output 9 works for the Class 6 D-style SmartMotor. Therefore, the valid EOFT(IO) values are:

l EOFT(9) to enable

l EOFT(-1) to disable
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Ethernet Error, Status Word 2 Bit 6

Ethernet Error, Status Word 2 Bit 6
The intent of Status Word 2 bit 6 is to inform the user that one or more errors has occurred through
the Ethernet interface. To determine the specific error that has occurred, consult the RETH command
description in the corresponding fieldbus guide.

I/O Control Details
The SmartMotor fieldbus guides describe the details of accessing I/O for each communication protocol.
The SmartMotor™ Developer's Guide also describes I/O control details.

In a local program or serial command, the OR, OS and OUT commands are the same as Class 5. For
details, see the SmartMotor™ Developer's Guide.

For the Class 6 D-style SmartMotor, it is important to note which are inputs, which are outputs, and
which have special functions. For those details, refer to the next table.
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I/O Control Examples

Logical
I/O

Number

Input or
Output

Possible
(Selectable)
Functions

Default Operation

0 Input only General purpose, discrete
or analog General purpose

1 Input only General purpose, discrete
or analog General purpose

2 Input only Positive limit, or general
purpose Positive limit

3 Input only Negative limit, or general
purpose Negative limit

4 Input/Output
General purpose, or index
capture for external
encoder

General purpose

5 Input/Output
General purpose, or index
capture for internal
encoder

General purpose

6 Input only General purpose, G com-
mand, or homing input General purpose

7 Input only Drive enable Drive enable

8 Input/Output General purpose or brake
output General purpose

9 Input/Output General purpose or not
fault output General purpose

I/O Control Examples
To read inputs:

x=IN(W,0,15) 'Reads inputs 0,1,2,3 as bitfield stored into variable x
EIGN(2) 'Disables positive limit, makes a general-purpose input
EIGN(3) 'Disables negative limit, makes a general-purpose input
EILP 'Re-enables positive limit
RIN(3) 'Reads input 3

Scale Factor Calculation – Sample Rates
The sample rate for Class 6 SmartMotors is fixed at 16,000 Hz (16 kHz).
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Commands for Class 6

Commands for Class 6
When transitioning from Class 5 to Class 6 motors, be aware that the commands in this section were
added for the Class 6 SmartMotor.

NOTE: These commands are not available for the Class 5 SmartMotor.

EOFT: Configure a specified output for the fault indication.

GROUP(function,value): Configure group addressing settings of the Combitronic over Ethernet (UDP)
communications.

IDENT=, RIDENT, x=IDENT: Set the IDENT value which is useful for user programs to detect which axis
they are. Report, use in expression, or assign the value of IDENT to a user variable.

IPCTL(action,"string"): Sets IP address, Mask, or Gateway:
action= 0, set IP address; 1, set Mask; 2, set Gateway;
"string": formatted as an IP address and entered as a string;
e.g., IPCTL(0,"192.168.0.10") sets IP address to 192.168.0.10

PRINT0: Explicitly outputs to the COM 0 serial port.

PRINT8: Explicitly outputs to the USB port.

RGROUP(function): Report group addressing setting of the Combitronic over Ethernet (UDP)
communications.

RSP5: Reports network interface card firmware version.

RUSB(arg), x=USB(arg): Report the value of the specified USB status word (specified by arg) or assign
it to a variable.

RUSB, x=USB: Report the value of USB status word 0 or assign it to a variable.

SNAME("string"): Sets a unique PROFINET station name. See the Class 6 SmartMotor™ PROFINET
Guide.

For details on these commands, see the SmartMotor™ Developer's Guide.

These Industrial Ethernet (IE) commands were added for the Class 6 SmartMotor:

NOTE: These commands are not available for the Class 5 SmartMotor.

RETH(arg), x=ETH(arg): Assign result to a variable or report errors and certain status information for
the EtherCAT or PROFINET bus. See the corresponding fieldbus manual for arg values.

ETHCTL(action,value): Controls network features. See the corresponding fieldbus manual for details.

For details on these commands, see the Class 6 SmartMotor EtherCAT Guide or the Class
6 SmartMotor™ PROFINET Guide.
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Commands That Have Changed

Commands That Have Changed
These commands have been modified for the Class 6 D-Style SmartMotor:

ENCCTL: Parameters were added for control of the Class 6 D-style batteryless absolute multiturn
encoder. For more information, see Batteryless Absolute Multiturn Encoder on page 65.

PRINT: Corresponds with the value of STDOUT, which is 0 (RS-232 port) by default. Note that this
behavior is different than in Class 5 motors.

STDOUT=0: (Default) Sets internal report commands to the COM 0/RS-232 port.

For details on these commands, see the SmartMotor™ Developer's Guide.

Commands Not Supported
These commands are not supported in the Class 6 D-style SmartMotor:

ENCD, EOIDX, MDH, MDHV, MDT, OC, OF, PID, SCALEA, SCALEP, SCALEV

Commands Supporting the DS2020 Combitronic System
Note that the Class 6 D-style motors support the DS2020 Combitronic system. Therefore, any
commands specific to that product are available on these motors.

For details on the commands for the DS2020 Combitronic system, see the topic "Commands for
DS2020 Combitronic" in the SmartMotor™ Developer's Guide.

Features not Available in Class 6 D-Style
These features are not implemented:

l DeviceNet protocol

l PROFIBUS protocol

l I²C communications

l AD1 option
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Troubleshooting

Troubleshooting
This section provides troubleshooting information for common problems. For additional support
resources, see: http://www.animatics.com/support.html.

Issue Cause Solution
Communication and Control Issues
Motor does not communicate
with SMI.

Transmit, receive or ground pins
are not connected correctly.

Ensure that transmit, receive and ground are all
connected properly to the host PC.

Motor program is stuck in a
continuous loop or is disabling
communications.

To prevent the program from running on power up, use
the Communications Lockup Wizard located on the SMI
software Communications menu.

Motor disconnects from SMI
sporadically.

COM port buffer settings are too
high.

Adjust the COM port buffer settings to their lowest
values. This is done In the Windows Device Manager>
Advanced Settings dialog box for the associated COM
port driver.

Poor connection on cable from
motor to PC.

Check the cable connections and/or replace it.

Power supply unit (PSU)
brownout.

PSU may be undersized for the application, which causes
it to brown-out during motion. Make moves less
aggressive, increase PSU size or change to a linear
unregulated power supply.

Motor stops communicating
after power reset, requires
redetection.

Motor does not have its address
set in the user program.
NOTE: Serial addresses are lost
when motor power is off or
reset.

Use the SADDR or ADDR= command within the program
to set the motor address.

Motor doesn't turn. Faults not cleared and/or drive
enable not satisfied.

Clear faults (see Checking and Clearing the Status Bits on
page 52).
Satisfy the drive enable input (see Drive Enable Input on
page 33).

No CAN bus signal on the fly-
ing lead cable

HD26 cable DIP switches are set
incorrectly.

Check the cable DIP switch settings. For CAN bus pass-
thru, switches 1 & 2 must be ON, switches 3 & 4 must be
OFF; reverse those settings for CAN bus termination.

Common Faults
Bus voltage fault. Bus voltage is too high for

operation.
Check servo bus voltage. Check for excessive
regenerative energy from motor due to no/insufficient
shunt resistor.

Bus voltage is too low for
operation.

If motor uses the dual-power configuration (separate
drive and control power supplies), ensure that both power
supplies are connected and are sized correctly for the
motor.

Overcurrent occurred. Motor intermittently drew more
than its rated level of current.
Does not cease motion.

Consider making motion less abrupt with softer tuning
parameters or lower acceleration profiles.

Excessive temperature fault. Motor has exceeded internal PCB
temperature limit of 85°C. Motor
will remain unresponsive until it
cools down below 80°C.

Motor may be undersized or ambient temperature is too
high. Check motor sizing for the application in terms of
continuous rating. Consider adding heat sinks or forced
air cooling to the system.

Excessive position error. The motor's commanded position
and actual position differ by
more than the user-supplied
error limit.

Increase error limit, decrease load or make movement
less aggressive. Also, ensure you are not voltage limited
for the torque at speed required. If running from less
than 48 VDC, check ratings for lower bus voltages and
ensure the motor is within required torque capacity.
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For Further Information...

Issue Cause Solution
Motor faults on position error
only after a certain amount of
time.

Motor sized incorrectly. Check motor sizing for the application in terms of
continuous rating. Also, ensure you are not voltage
limited for the torque at speed required. If running from
less than 48 VDC, check ratings for lower bus voltages
and ensure the motor is within required torque capacity.Motor is not accurately

corresponding to trajectory.
Programming and SMI Issues
Several commands not
recognized during compiling.

Compiler default firmware
version set incorrectly.

Use the Compiler default firmware version option in the
SMI software Compile menu to select a default firmware
version closest to the motor's firmware version. In the
SMI software, view the motor's firmware version by
right-clicking the motor and selecting Motor Properties.

For Further Information...
Now that your SmartMotor is installed and operating, the next step is to learn about its features,
commands and programming in order to create a useful application.

Information on SMI software features, SmartMotor programming, communications, motion control and
more is provided in the SmartMotor™ Developer's Guide. That guide also includes a complete
SmartMotor command reference, and an Appendix of other related topics that are useful during
application development.
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